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INTENDED USE 

The guidelines describe the procedure of using AmpliSens® Rubella virus-FRT PCR kit 

for qualitative detection of Rubella virus RNA in the clinical material (peripheral and 

umbilical cord blood plasma, saliva, oropharyngeal swabs, and amniotic fluid) by the 

polymerase chain reaction (PCR) with real-time hybridization-fluorescence detection using 

the following instruments:  

- Rotor-Gene 3000, Rotor-Gene 6000 (Corbett Research, Australia); 

- iCycler iQ, iCycler iQ5 (Bio-Rad, USA); 

- Mx3000P, Mx3005P (Stratagene, USA). 

and also in combination with the automatic station for the nucleic acids extraction 

NucliSENS easyMAG (bioMérieux, France). 

WORK with the NucliSENS easyMAG AUTOMATED NUCLEIC ACID EXTRACTION 

SYSTEM 

Variant 1  

RNA extraction with lysis of sample outside of the instrument (off-board mode) 

This method of extraction allows reducing the consumption of NucliSens lysis buffer. It is 

preferred for working with clinical samples which contain clots (saliva). 

1. Switch on the NucliSENS easyMAG instrument and prepare it to the RNA extraction 

according to the instruction manual. 

2. In the window for input of test samples, enter the following parameters: 

• Sample name 

• Matrix for RNA extraction (select Other) 

• Volume – 0.1 ml 

• Eluate – 55 μl 

• Type – Lysed 

• Priority – Normal. 

3. Create a new protocol of RNA extraction and save it. In the protocol select On-board 

Lysis Buffer Dispensing - No, On-board Lysis Incubation - No. 

4. Relocate the sample table into the created protocol. 

5. Take the required quantity of special disposable tubes intended for RNA extraction in 

the NucliSENS easyMAG instrument (including Negative Control of extraction). Add 

10 μl of Internal Control STI-87 to inner walls of each tube and then add 550 μl of 

NucliSens lysis buffer. 
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When working with material which contains clots, lysis should be carried out in 
1.5-ml tubes. After finishing the incubation (see item 8), tubes should be 
centrifuged at 10,000 rpm for 1 min. Then transfer the supernatant into special 
tubes intended for RNA/DNA extraction in the NucliSENS easyMAG instrument 

6. Add 100 μl of prepared samples into each tube with Lysis buffer and Internal Control 

STI-87-rec by using disposable tips with aerosol barriers and carefully mix by pipetting 

(avoid getting mucus clots and big particles into the tube). 

7. Add 100 μl of Negative Control into the tube with the Negative Control of Extraction 

(C–). Add 90 μl of Negative Control and 10 μl of Positive Control Rubella virus-rec 

(PCE) into the tube with the Positive Control of Extraction (PCE). 

8. Incubate the tubes for 10 min at room temperature. 

9. Resuspend the tube with magnetic silica NucliSens (bioMérieux) by intensive 

vortexing. Add 25 μl of magnetic silica by using disposable tips with aerosol barriers 

and carefully mix by pipetting. Magnetic silica should be distributed evenly over the 

tube volume. 

10. Place the tubes with samples into the instrument and start the RNA extraction program 

with lysis of samples by selecting the Off-board mode. 

11. After the extraction is finished, take the tubes out of the instrument and carry out the 

RT-PCR not later than 30 min after RNA extraction.  

If necessary to store, transfer purified RNA into sterile tubes within 30 min after RNA 

extraction.  

The purified RNA should be stored at 2–8° C for 8 hours, at the temperature ≤ –16 °C 

for 1 month, and at the temperature ≤ –70° C for a long time. 

Variant 2 

RNA extraction with automated lysis of sample in the instrument (on-board mode) 

1. Switch on the NucliSENS easyMAG instrument and prepare it for the RNA extraction 

according to the instruction manual. 

2. In the window for input of test samples, enter the following parameters: 

• Sample name 

• Matrix for RNA extraction (select Other) 

• Volume –0.1 or 1 ml 

• Eluate – 55 μl 

• Type – Primary 

• Priority – Normal. 

3. Create a new protocol of RNA extraction and save it. In the protocol, select On-board 
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Lysis Buffer Dispensing - Yes, On-board Lysis Incubation - Yes. 

4. Relocate the programmed sample into the created protocol. 

5. Take the required quantity of special disposable tubes intended for RNA extraction in 

NucliSENS easyMAG instrument (including negative control of extraction). Add 10 μl of 

Internal Control STI-87-rec into each tube along the internal walls. 

6. Add 100 μl of prepared samples into each tube with lysis buffer and Internal Control 

by using disposable tips with aerosol barriers and carefully mix by pipetting (avoid 

getting mucus clots and big particles into the tube). 

7. Add 100 μl of Negative Control into the tube with Negative Control of Extraction (C-). 

Add 90 μl of Negative Control and 10 μl of Positive Control Rubella virus-rec (PCE) 

into the tube with the Positive Control of Extraction (PCE). 

8. Place the tubes with samples into the instrument, place the tips and run the RNA 

extraction with lysis of samples in the instrument (the On-board mode). 

9. Wait until the NucliSENS easyMAG instrument proceeds to the Instrument State–Idle 

option and pauses. 

10. Thoroughly vortex the tube with magnetic silica NucliSens (bioMérieux). Open the lid 

of instrument and add 25 μl of magnetic silica into each tube by using disposable tips 

with aerosol barriers (or by using multichannel pipettes with disposable tips with 

aerosol barriers for 200 μl) and carefully mix by pipetting. Magnetic silica should be 

distributed evenly over the tube volume. 

11. Close the lid of the instrument and continue the RNA isolation program. 

12. After the extraction is finished, take the tubes out of the instrument and carry out the 

RT-PCR not later than 30 min after RNA extraction. 
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AMPLIFICATION AND DATA ANALYSIS USING Rotor-Gene 3000/6000 (Corbett 

Research, Australia) INSTRUMENT 

Insert the tubes into the rotor of the Rotor-Gene 3000/6000 instrument beginning from the 

first well (the rotor wells are numbered, the numbers are used for the further programming 

of the samples’ order in the thermocycler). Insert the rotor into the instrument, close the lid. 

 

If some wells of the rotor remain unloaded, the rotor should be balanced. Place 
empty tubes into the empty wells. Do not use tubes from the previous tests. Well 
1 must be filled with any test tube except for an empty one. 

Hereinafter, all the terms corresponding to different instruments and software are 

indicated in the following order: for Rotor-Gene 3000 / for Rotor-Gene 6000. 

Programming the Rotor-Gene 3000/6000 instrument 

1. Click the New button in the software main menu. 

2. In the window, select the Advanced menu and select Dual Labeled Probe/Hydrolysis 

probes. Click the New button.  

3. In the opened window, select 36-Well Rotor (or 72-Well Rotor) and No Domed 0.2 ml 

Tubes/Locking ring attached. Click the Next button. 

4. In the opened window enter the operator name, and select the reaction mixture volume: 

Reaction volume – 25 µl. Select 15 µl oil layer volume. Press the New button. 

5. In the opened window set the temperature profile of the experiment. To do this click the 

Edit profile button and set the amplification program:: 

Table 1 
AmpliSens-2 amplification program 

Step Temperature, °С Time Fluorescence detection Number of cycles 

Hold 50 15 min – 1 

Hold 2 95 15 min – 1 

Cycling 

95 5 s – 

5 60 20 s – 

72 15 s – 

Cycling 2 

95 5 s – 

40 60 20 s 
FAM/Green, JOE/Yellow, 
ROX/Orange, Cy5/Red 

72 15 s – 
 

 

It is possible to carry out any combination of tests that use the AmpliSens-2 
universal amplification program (for example, HCV-genotyping, etc.) within the 
same run. ROX/Orange and Cy5/Red channels are activated if necessary (for 
“multiprime” format tests). 

 

6. After setting up the temperature profile click the OK button. 

7. In the New Run Wizard window, click the Calibrate or Gain Optimisation button.  
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– Perform calibration in FAM/Green and JOE/Yellow channels (press the Calibrate 

Acquiring/Optimise Acquiring button).  

– Perform calibration before the first measurement (Perform Calibration Before 1st 

Acquisition or Perform Optimisation Before 1st Acquisition).  

– Set the calibration of the channels for all dyes from 3Fl to 8Fl (Edit… button, Auto 

gain calibration channel settings window). Press the Close button. 

8. Click Next. Then press the Start run button for amplification run. 

9. Name the experiment and save it to the disk (results of the experiment will be 

automatically saved in this file). 

10. Enter the data in the grid of the samples (it opens automatically after amplification has 

been started). Enter the names/numbers of the test samples in the Name column. 

Define the Negative Control of amplification as NCA and the Positive Control of 

Amplification as C+. Set the type Unknown opposite all the tested samples, the type 

Positive Control - for the Positive Control of amplification, the type Negative Control - for 

the Negative Control of Amplification. Set the type None for the cells matching with the 

corresponding empty tubes. 

 
Samples indicated as None won’t be analysed. 

Data analysis:  

The obtained results (fluorescence accumulation curves for two channels) are analyzed by 

the instrument software. Accumulation of the Internal Control STI-87-rec cDNA 

amplification product is detected in the FAM/Green channel, Rubella virus cDNA is 

detected in the JOE/Yellow channel. 

The obtained results are analyzed by the Rotor-Gene software. The results are interpreted 

according to the crossing (or not-crossing) of the S-shaped (sigmoid) fluorescence curve 

with the threshold line set at the specific level, that corresponds to the presence (or 

absence) of the Ct (threshold cycle) value of the cDNA sample in the corresponding 

column of the results table. 

Amplification data analysis for the Rubella virus cDNA (JOE/Yellow channel). 

1. Activate the button Analysis in the menu, select the mode of the analysis 

Quantitation, activate the Cycling A. FAM/Cycling A. Green, Show buttons. 

2. Cancel the automatic choice of the threshold line level Threshold. 

3. Activate the Dynamic tube and Slope Correct buttons in the menu of main window 

(Quantitation analysis). 

4. In the CT Calculation menu (in the right part of the window), indicate the threshold line 
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level 0.03 in the Threshold box. 

5. Choose the parameter More settings/Outlier Removal and set 10 % for the value of 

negative samples threshold (NTC/Threshold). 

6. In the results grid (the Quantitation Results window) one will be able to see the Ct 

values. 

7. For Negative Control of Extraction (C-) – Negative Control (C-) - Ct values should be 

absent. 

8. For Negative Control of Amplification (NCA) – RNA-buffer – Ct values should be 

absent. 

9. For the Positive Control of Extraction – Positive Control cDNA Rubella virus / STI 

(C+) – the Ct value should be less than the value specified in the Important Product 

Information Bulletin. 

10. For Positive Control of Amplification – Positive Control Rubella virus-rec – the Ct 

value should be less than the value specified in the Important Product Information 

Bulletin. 

Amplification data analysis for IC (FAM/Green channel). 

1. Activate the button Analysis in the menu, select the mode of the analysis 

Quantitation, activate Cycling A. FAM/Cycling A. Green, Show buttons. 

2. Cancel the automatic choice of the threshold line level Threshold. 

3. Activate the Dynamic tube and Slope Correct buttons in the menu of main window 

(Quantitation analysis). 

4. In the CT Calculation menu (in the right part of the window), indicate the threshold line 

level 0.03 in the Threshold box. 

5. Choose the parameter More settings/Outlier Removal and set 10 % for the value of 

negative samples threshold (NTC/Threshold). 

6. In the results grid (the Quant. Results window), one will be able to see the Ct values 

for Internal Control STI-87 (IC) for each test sample. 

7. For Negative Control of Amplification (NCA) – RNA-buffer – Ct values should be 

absent. 

8. For the Positive Control of Extraction – Positive Control cDNA Rubella virus / STI 

(C+) – the Ct value should be less than the value specified in the Important Product 

Information Bulletin. 

9. For Negative Control of Extraction (C-) – Negative Control (C-) – Ct values should not 

exceed the boundary Ct value specified in the Important Product Information Bulletin. 
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AMPLIFICATION AND DATA ANALYSIS USING iCycler iQ5 and iCycler iQ (Bio-Rad, 

USA) INSTRUMENTS 

1. Turn on the instrument and start the iQ5 program. 

 

The lamp is to be warmed up during 15 min before starting the experiment. 

2. Insert the tubes, strips (part of the plate) or the plate into the reaction module. Program 

the instrument. 

 

Monitor the tubes. There must not be drops left on the walls of the tubes as 
falling drops during the amplification process may lead to the signal failure and 
complicate the results analysis. Don’t turn the tubes (strips) upside down while 
inserting them into the instrument. 

Program the thermocycler according to manufacturer’s manual. 

1. Click the Create New button in the Workshop module to create a new protocol. 

2. Set the amplification parameters in the opened window (see Table 2). 

Table 2 
AmpliSens-2 amplification program 

Step Temperature, °С Time Fluorescence detection Number of cycles 

1 50 15 min – 1 

2 95 15 min – 1 

3 

95 5 s – 

5 60 20 s – 

72 15 s – 

4 

95 5 s – 

40 60 20 s FAM, JOE/HEX, ROX, Cy5 

72 15 s – 
 

 

It is possible to carry out any combination of tests that use the AmpliSens-2 
universal amplification program (for example, HCV-genotyping, etc.) within the 
same run. ROX and Cy5 channels are activated if necessary (for “multiprime” 
format tests). 

 

3. Name the new protocol and save it. 

4. Create the new plate of samples - Plate setup. Set the order of the tubes in the plate. 

5. In the open window, mark all clinical samples as Unknown, positive controls as «+», and 

negative controls as «–». Set the fluorescence measurement in 2 channels (HEX-530 

and FAM-490) for all samples.  

6. Name the scheme of the tubes order and save it 

7. Click the Run button (for iCycler iQ5) or the Run with selected protocol button (for 

iCycler iQ). Set the volume of the sample as 25 µl. For iCycler iQ, select Experimental 

Plate to determine the well factor. For iCycler iQ5, both the mode with measurement of 

well factors by experimental tubes and the mode with fixed well factors (recommended) 
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can be used. Click the Begin Run button and save the experiment. 

 

Data analysis  

The obtained results (fluorescence accumulation curves for two channels) are analyzed by 

the instrument software. Accumulation of the Internal Control STI-87-rec cDNA 

amplification product is detected in FAM channel, Rubella virus cDNA – in the JOE/НЕХ 

channel.  

The results are interpreted according to the crossing (or not-crossing) of the fluorescence 

curve with the threshold line set at the specific level, that corresponds to the presence (or 

absence) of the Ct (threshold cycle) value of the DNA sample in the corresponding column 

of the results table.  

Data processing 

1. Start the software and open the saved file: select Data file in the Workshop module 

and select the data file. Proceed to the Data Analysis mode. 

2. View data separately for each channel.  

3. Select Log View for each channel. Set the threshold line (with the left mouse button) at 

a level where fluorescence curves have a linear character. 

 

 

4. In order to analyze the results click the Results button which is situated under the 

buttons with the fluorophores’ names (for iCycler iQ5) or PCR Quant button (for 

iCycler iQ). In the results grid (Quant. Results window) the Ct values for each channel 

will appear. 

Amplification data analysis for the Rubella virus cDNA (JOE/НЕХ channel). 

1. Microsoft Excel window will open. In the results grid the Ct values will appear (column 

Ct (dR)).  

2. For Negative Control of Extraction (C-) – Negative Control (C-) – Ct values should be 

absent. 

Threshold 
line 

Zone of 
fluorescence 
curve linearity 
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3. For Negative Control of Amplification (NCA) – RNA-buffer – Ct values should be 

absent. 

4. For the Positive Control of Extraction – Positive Control cDNA Rubella virus / STI 

(C+) – the Ct value should be less than the value specified in the Important Product 

Information Bulletin. 

5. For Positive Control of Amplification – Positive Control Rubella virus-rec – the Ct 

value should be less than the value specified in the Important Product Information 

Bulletin. 

Amplification data analysis for the IC (FAM channel). 

1. Press the FAM button in Dyes Shown window.  

2. Select Text Report in Area to analyze. Open the File menu, then select Export Text 

Report and Export Text Report to Excel. Ct values will appear in the column Ct (dR).  

3. For Negative Control of Amplification (NCA) – RNA-buffer – Ct values should be 

absent. 

4. For the Positive Control of Extraction – Positive Control cDNA Rubella virus / STI 

(C+) – the Ct value should be less than the value specified in the Important Product 

Information Bulletin. 

5. For Negative Control of Extraction (C-) – Negative Control (C-) – Ct values should be 

less than the value specified in the Important Product Information Bulletin. 



REF  R-V24-S(RG,iQ,Mx)-СE / VER  04.07.13–01.03.21 / Page 12 of 16 

AMPLIFICATION AND DATA ANALYSIS USING Mx3000P, Mx3005P (Stratagene, 

USA) INSTRUMENT 

1. Switch on the instrument. Run the software Stratagene Mx3000P. 

2. Select Quantitative PCR (Multiple Standards) and Turn lamp on for warm-up in 

New Experiment Options window.  

 

The lamp is to be warmed up during 15 min before starting the experiment. 

3. Insert the tubes into the instrument and close the lid. 

4. Select Optics Configuration in the Options menu and in Dye Assignment tab set 

JOE parameters opposite to the HEX/JOE filter set item, FAM parameters in front of 

the FAM filter set item. 

 

Don’t turn the strips/plate upside down while inserting them into the instrument. 

5. Lock the fixing arm and the door of the instrument 

6. Select Quantitative PCR (Multiple Standards) in New Experiment Options window and 

set Turn lamp on for warm-up. 

7. Set fluorescence detection parameters in the Plate Setup menu. For this: 

– Select all wells with the test tubes or strips (hold Ctrl button down and select the 

necessary region with the mouse). 

– Mark all selected cells as Unknown in the Well type window. Set FAM and JOE in 

Collect fluorescence data option. Name each sample by double clicking on each cell 

(Well Information window).  

8. Set fluorescence detection parameters for tubes in the Plate Setup tab. For this: 

– Select all cells with analysis tubes or strips (holding Ctrl down and selecting the 

required range) 

– Mark all selected cells as Unknown in the Well type window. Set FAM and JOE in 

Collect fluorescence data option. Name each sample by double clicking on each cell 

(Well Information window), positive control indicate as +, negative - as -. 

9. In the Thermal Profile Setup tab, set the amplification program according to the one of 

this modes: 

Using of the template file for setting the amplification program (is recommended). 

Press the Import… button right to thermocycling profile picture. Proceed to the folder 

containing previous experimental file and open it. In the Thermal Profile window required 

thermocycling profile will appear. 
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Individual programming. 

1. After setting all necessary values and parameters, select all wells with tested microtubes 

again. Proceed to Thermal Profile Setup menu, set the amplification program specified in 

the Table 3. 

Table 3 
AmpliSens-2 amplification program 

Step Temperature, °С Time Fluorescence detection Number of cycles 

1 50 15 min – 1 

2 95 15 min – 1 

3 

95 5 s – 

5 60 20 s – 

72 15 s – 

4 

95 5 s – 

40 60 20 s FAM, JOE/HEX, ROX, Cy5 

72 15 s – 
 

 

It is possible to carry out any combination of tests that use the AmpliSens-2 
universal amplification program (for example, HCV-genotyping, etc.) within the 
same run. ROX and Cy5 channels are activated if necessary (for “multiprime” 
format tests). 

2. To set detection parameter of fluorescent signal at desired temperature, select the All 

points option for Data collection by marker dragging parameter and move it by mouse 

from right side to the shelf with desired temperature. 

3. Select Run and Start and name the experiment file. 

Data analysis 

The obtained results (fluorescence accumulation curves for two channels) are analyzed by 

the instrument software. Accumulation of the Internal Control STI-87-rec cDNA 

amplification product is detected in FAM channel, Rubella virus cDNA – in JOE/НЕХ 

channel. 

The results are interpreted according to the crossing (or not-crossing) of the fluorescence 

curve with the threshold line set at the specific level, that corresponds to the presence (or 

absence) of the Ct (threshold cycle) value of the DNA sample in the corresponding column 

of the results table. 

Data processing 

1. In Mx3000P software, select Analysis by clicking the corresponding button of the tool 

bar. 

2. The Analysis Selection/Setup tab will open. Make sure that all the test samples are 

active (the cells corresponding to the samples should be of a different colour). 
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Otherwise select all the test samples by holding down the Ctrl button and selecting the 

needed range with the mouse. 

3. Select the Results tab. 

4. Make sure that two fluorescence channels are active (the HEX and FAM buttons are 

activated in the Dyes Shown field in the lower part of the program’s window). 

5. Select the Threshold fluorescense field and make sure that tick marks are put against 

two fluorescence channels: JOE/HEX and FAM. Check the correctness of the 

automatically chosen threshold line. Normally, the threshold line is to intersect only with 

S-shaped curves describing the accumulation of the signal detecting positive samples 

and controls The threshold line is not to cross the base line. If it happens, it is 

necessary to raise the threshold level. 

6. Select Text Report point in the Area to analyze window. Visually ensure that all data 

is sorted by the name of dyes (the Dye column). To do this, press once the name of the 

column (Dye). 

7. Select Export Text Report in the File menu, then select Export Text Report to Excel. 

A Microsoft Excel window will open. 

Amplification data analysis for the Rubella virus cDNA (JOE/НЕХ channel) 

1. Microsoft Excel window will open. In the results grid, Ct values will appear (column Ct 

(dR)). 

2. For Negative Control of Extraction (C-) – Negative Control (C-) – Ct values should be 

absent. 

3. For Negative Control of Amplification (NCA) – RNA-buffer – Ct values should be 

absent. 

4. For the Positive Control of Extraction – Positive Control cDNA Rubella virus / STI 

(C+) – the Ct value should be less than the value specified in the Important Product 

Information Bulletin. 

5. For Positive Control of Amplification – Positive Control Rubella virus-rec – the Ct 

value should be less than the value specified in the Important Product Information 

Bulletin. 

Amplification data analysis for the IC (FAM channel) 

1. Activate the FAM button in the Dyes Shown window.  

2. Select Text Report in the Area to analyze. Open the File menu, then select Export 

Text Report and Export Text Report to Excel. Ct values will appear in the Ct column 

(dR) of the results grid.  
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3. For Negative Control of Amplification (NCA) – RNA-buffer – Ct values should be 

absent. 

4. For the Positive Control of Extraction – Positive Control cDNA Rubella virus / STI 

(C+) – the Ct value should be less than the value specified in the Important Product 

Information Bulletin. 

5. For Negative Control of Extraction (C-) – Negative Control (C-) – Ct values should be 

less than the value specified in the Important Product Information Bulletin.. 
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List of Changes Made in the Guidelines 

VER Location of changes  Essence of changes 

11.05.11 
RT 

Amplification and 
data analysis using 
Rotor-Gene 
3000/6000 
instrument (Corbett 
Research, Australia). 
Programming the 
Rotor-Gene 
3000/6000 
instrument 

In item 5 table 1 was deleted (Amplification program) 

Amplification and 
data analysis using 
iCycler iQ/iQ5 
instruments (Bio-
Rad, USA) 

In item 2 table 3 was deleted (Amplification program) 

Amplification and 
data analysis using 
Mx3000P, Mx3005P 
(Stratagene, USA). 
Manual 
programming 

In item 1 table 5 was deleted (Amplification program) 

23.06.11 
LA 

Cover page 
The name of Institute was changed to Federal Budget Institute 
of Science “Central Research Institute for Epidemiology” 

01.02.12 
VV 

Amplification and 
data analysis using 
Rotor-Gene 
3000/6000 
instrument (Corbett 
Research, Australia)  
Data analysis of the 
Rubella virus cDNA 
(JOE/Yellow 
channel). 

The phrase “The NTC threshold value can be raised to 20% 
if a weak signal (Ct) from the Green/FAM channel is 
detected for the positive control of RT-PCR in the 
Yellow/JOE channel. The nonspecific signal associated with 
cross-detection has a lower rise value than the specific 
signal” was deleted. 

31.07.13 
ME 

Cover page  symbol was added 

Footer REF  R-V24-S(RG,iQ,Mx)-СE-B was deleted 

02.07.15 
PM 

Through the text Corrections according to the template 

27.02.20 
PM 

Front page The phrase “Not for use in the Russian Federation” was added 

01.03.21 
KK 

— 
The name, address and contact information for Authorized 
representative in the European Community was changed 

 


